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The following items listed are enhancements/fixes the State is putting into the MAAP Production server.
A joint effort between DMV/OIT/Interware and BMSI produced these as outlined below. Interware has
been testing these in MAAP Cert Server since July 19"

- Users will now be able to assign supervisor privileges when they have an open closeout.

- MAAP will now accept a leased vehicle with multiple lessees

- When going from a CPASS to an HPASS, MAAP will no longer charge an extra month

- MAAP will no longer stop the transaction in Registration Maintenance -> decal replacement if an
open shortslip is present on the name of the primary owner

- MAAP will no longer charge a plate fee when putting an expired plate on a new vehicle. Users will
release the plate as Available in Inventory — Vanity or Non-Vanity. Users will no longer have to
enter a short slip with RHDONTUEOL code.

- MAAP will no longer allow the user to complete the state portion of a renewal or transfer of
controlled plates if the names are changing.

- During a transfer in which the old vehicle has been sold, MAAP will now let the user complete the
transaction.

- Users can now send multiple tender types for state work.

- Seller date of birth is no longer a required field. Users can leave it blank and MAAP will allow it to
go through.

- Users can now enter new Lienholder without the Lienholder number and MAAP will allow it to go
through.

- Users will no longer encounter the MAXMS exception: Null error due to the Gender not being
present in the state data, Further MAAP will accept a user entered Gender only if it is blank
coming in from MAAP.

- On a reprint registration with no state work, the ring line will not print.

1.1.2.80 Release Date July 20, 2006 *rxxTable Changes*****

SEARCH PAYMENT ADJUSTMENTS - Users can now Search Payment Adjustments to find out what
transactions have gone through to MAAP. However, a user cannot search their own transactions;
another User must log in to perform the search. Simply go to MAAP ->Search Payment Adjustments to
search MAAP. Type in the User Name, Closeout Date, and Closeout Sequence and click Search MAAP.
All transactions that have been successfully transmitted to MAAP will be returned. Highlight a particular
transaction and choose the “Tender” tab at the bottom to display Tender information. Click on the
“Registrations” tab to show all the individual registrations associated with the highlighted transaction.

TITLES; RECEPT FLOW CHANGE - To mitigate the Title Mismatch issues, there is a new flow to the
ClerkWorks XML receipt. After typing in the VIN number, ClerkWorks XML will automatically search
MAAP for any title associated with that VIN. The list will be presented in chronological order with the
most recent on top. If there is a Title in the list with the current owner’'s name on it, the user will not have
to prepare a Title Application. If no title comes back for the person who is registering the vehicle, users
can simply click the button on the top left hand side of the window ‘Prepare Title’. The CTA window will
appear with the prior title number and state already in place. Once the Title Application has been
prepared, users will click OK and then click the select button or CTRL+END to select the Title Application
into the receipt. In addition the title status is now color coded.



Title status codes include:

AP — Applied for RV - Revoked
SU — Surrendered TR - Transferred
AS — Assigned VA - Valid

NS - Surrendered out of state

PAYTYPE ADJUSTMENT - If a user inadvertently sends up the wrong payment type, they now have the
ability to correct it in MAAP... after fee settlement has been made! In Void and Edit there is now an icon
for payment adjustment. Locate the receipt with the error and click the payment adjustment icon. A
window will appear with a From field, already populated with the current paytype, and a To field where
the user will type in the corrected paytype. Simply give a reason for the adjustment and click OK. The
corrected paytype will be transmitted to MAAP.

NEW PLATE ON RENEWAL- An issue in a previous release (.74) where the system would not process a
plate change on a renewal has been fixed. Simply put the old plate number in the previous plate number
field and the new plate in the second number field. Choose a reason for the plate change and process as
usual.

DUPLICATE VIN - When the user types in a VIN number that has more than one match, the user will get
a list of the vehicles with the same VIN. Scan the list carefully and choose the right vehicle for the
registration

PRINT SLIPS - Line feeds have been removed from Print slips so that all the information will now have
room to print.

MULTI-AXLE TRAILERS- Users will now be alerted when they try to register a trailer with more than one
axle with a Title Status of EX. The title status cannot be EX, these are titled vehicles.

MULTIPLE VEHICLES- When pulling in a plate from MAAP, and MAAP has more than one vehicle with
that plate, users will now be presented with a choice of which vehicle to register. The list will include
registrant, make, model, VIN and color.

TENDER WINDOW- When a shortslip exists for a given customer, ClerkWorks XML will now add the
shortslip total to the current state charges to the tender window.

Total Due... Receipt No: 2180
Local: $116.560 State: $94.60 Other: $0.00 Total: $211.10
Category |PayT_l,lpe |Item Mo |NameKey |Am0unt |

_8 55 10035593 085DF3227 ($8.30)

_8 CA, SAAD FRANCINE M $94 60

L  Ead SAAD FRANCINE M $116.50

Paid:  $211.10

Cash Tendered:

Balance Due: $211.10 Change Due- $0.00

Check | ok | Close |

CASH TENDERED- The cash tendered field in the Tender window now displays only the cash tendered,
not the amount of any check.

HANDICAPPED INDICATOR- There is now a handicapped indicator field in the Owners Window.

1.1.2.77 Release Date July 12, 2006



SELLERS- In certain specific instances, the seller was not printing on the title. ClerkWorks XML will now
save the seller information in every case and print properly.

OWNERS- When processing a registration for two owners new to MAAP, the primary owner sporadically
printed out twice. A change was made to the way ClerkWorks XML saves the owners and will now print

properly.

EXTENSIVE NEW SEARCH REGISTRATION CAPABILITIES!! — Plate Registrations - Users can now
search registrations by VIN, Decal, Plate Number, or Owner ID. There is an option on the MAAP Main
dropdown Menu called Search Registrations. The user can search MAAP to see the entire registration
history of a vehicle, an owner, or search for a particular decal. Users can also click on the clipboard in
the Search Registrations window to copy the VIN.

CWXML will now warn a user when the fees that the state calculates and the fees that Clerkworks
calculates are different.

1.1.2.74 Release Date July 5, 2006

TITLE ACTIVITY- When Clerkworks goes out and searches a VIN for a new or transfer, it will leave the
title activity field blank. You will fill in whether it is AP — meaning you have the dealer or lender blue copy
or PS — if you have the original CO or Title from the customer. This will lead to lesser issues for fees
relating to titles.

1.1.2.73 Release Date June 29, 2006

STICKER INVENTORY - This release fixes the problem with the previous release, 1.1.2.72, that did not
allow stickers to be entered into inventory.

1.1.2.72 Release Date June 29, 2006

EXTENSIVE NEW SEARCH TITLE CAPABILITIES !! — Titles - Users can now search titles by VIN,
CTA, Title Number, or Owner ID. There is an option on the MAAP Main dropdown Menu called Search
MAAP Titles. The user can search MAAP to see the entire title history of a vehicle, an owner, or search
for a particular CTA or title. Users can also access this feature by clicking on the dollar sign icon in the
VIN field of the receipt. Users can also click on the clipboard in the Search MAAP Titles window to copy
the title number, prior title number and state to paste into their CTA.

If your MAAP Menu from the Main Tool bar does not show “Search MAAP Titles” you will need to Reset
your Toolbar. To do this go to the little arrow under the Top Right Red X to expose the Add or Remove
Buttons verbiage and arrow. Then Drop down to the Reset Toolbar and click.

Add or Remove Buktons -
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MAIL IN NOTICES OVERWEIGHT STATE CALCULATIONS — The standard mail in notice has been
altered due to overweight vehicles. There was a problem revealed where the State amount in the detail
lines of the mail in notice was 0 but the Total State Fees listed below this detail included the state amount
as it is calculated when overweight.

Your support staff can fix this by editing the mail in report. Go to the D (Detail line) where the
@.State_Fees is located (the last field on the line). Highlight the @State_Fees field and Right Click ->
Edit Field Object. Rem out (use a // infront of lines not wanted) all lines leaving just

tcmailins.State Fees

B Formula Editor: @StateFees
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CHECK VALIDATE - Now when validating checks via File -> Check Validate users can filter or search by
Clerk. This will assist ClerkWorks multi users on the system when validating checks after the Receipt is
closed. The default user is the ClerkWorks XML user that is logged into that workstation.

60-DAY HARDSHIP — This verbiage has been added to the drop down arrow of the State General
Information line of a Receipt. Choose from the dropdown or simply type the first couple characters and
enter.

MAAP USERNAME - When entering a MAAP username, it now defaults to lowercase
REDBOOK VIN LOOKUP — Now, when users go outside the flow of ClerkWorks XML within a receipt and
go back to the VIN after having entered the Color/Axels/Cylinders (ie the user notices the weight or list

price is wrong) these fields will not be over written or cleared.

F7, AUTO SELECT OFF — Now when F7 (Auto Select Off) is invoked within the Receipt Screen the
expiration date will now populate.



ACTION MENU FLOW CHANGE - In some cases the Action Menu has been going to Print Title when it
should not stop there. This has been altered so when a Title print is not necessary it will not stop at the
Print Title.

STICKER INVENTORY — Now when adding stickers to sticker inventory the screen will refresh after each
set of stickers are added.

PLATE INVENTORY — When adding plate inventory for many plate types, after adding one and saying
Yes to add more, the screen will now refresh.

REPLICATE PLATE — Now when using Replicate Plate the final Y or N will replicate.

MAAP SEARCH IN CORPORATE SELLER — The Search MAAP picture icon is back at the end of the
Corporate Seller field.

LEASE CHECK BOX — Now if you pull a Lease company in from MAAP on a new registration, it will
automatically check the Lease Box.

RINGLINE — On rare occasions, the ringline was not printing on registrations when Fee Settlement was
successful. The MAAP Transaction information was in Void and Edit, but not Reg History. ClerkWorks
now saves to both Reg History and Void and Edit in all cases.

POINT OF SALE - Fee Settlement was added to the Action Menu of Point of Sale

STATE GENERAL INFORMATION LINE - When doing a duplicate registration, DUPLICATE will now print
and stay at the top of the registration. Also if a Duplicate Registration is done then a transfer right
afterwards the Reason verbiage (ie Lost) will clear.

MAIL IN NOTICES - When generating Mail In Notices with the status of USPS, ClerkWorks XML would

only pull records with a “U” in the mail in field, not USPS. This has been fixed and ClerkWorks XML will
now pull all records with a U or a USPS as specified in the first Screen of Generate Mail Notices.

1.1.2.70 Release Date June 20, 2006

LIENHOLDERS - Can now search Lienholders by ID without an Access violation. Users will get a
warning if they try to delete a Lienholder that is connected to a title.

1.1.2.69 Release Date June 19, 2006

VEHICLES- ClerkWorks XML now harvests all the vehicle information from MAAP with the exception of
list price and last months and mills. This should mitigate the Title Weight issue that has cropped up
recently.

1.1.2.68 Release Date June 16, 2006

DUMMY TITLES - There is now an Autofill button to use when ‘dummying’ on a title. Choose Get new
CTA number as before and then click Autofill. All the required information for a dummy title will

automatically fill in.

PLATE RELEASE- When releasing a plate, the correct reason code for several common scenarios are
listed to help users choose the correct way to release the plate.

OWNER SEARCH AND MAINTENANCE- Owner Search and Maintenance is now accessible from the
Motor Vehicle Dropdown menu while in an active receipt.

1.1.2.67 Release Date June 13, 2006 Table Change (SystemMstr)

OFFLINE CAPABILITIES — There is a check off box in the System Master that allows full functionality of
ClerkWorks XML without being on line with MAAP. Towns will enjoy split tenders, lien holder lists and



get used to the new XML working completely off line. Conversion, State Data load and other XML set up
is necessary by your support group.

RECEIPT — Users can now enter a transaction id number on the receipt.
DRIVERS/LESSEE — Now appear in the appropriate places on the title and will be identified.

VEHICLES — When all the information for the vehicle is entered for the registration, and a person goes to
the Redbook lookup, it will not overwrite this information.

1.1.2.64 Release Date June 13, 2006 Suspected Table Change

TITLE SCREEN - If you are offline with MAAP and press F6 in the title field a message will appear that
you need to be on line with MAAP. If you are online, it will give you a message that you need information.
The Ellipse will always look up into your local data.

TITLES — The previous title number field has been enlarged to include 17 digits.

PAY TYPE — The pay type will now appear at the bottom of the registration next to the receipt number.
Be aware that it is printing the first entry of the LOCAL PAY TYPE only.

OWNERS - If there is one owner without an ID number, a message will appear to let you know which
owner is missing the ID number instead of giving you a message that both owners are missing the ID
number even though one did have it.

FANTOM SECOND OWNER - A second owner from a previous registration no longer appears on future
receipts. A core clearing issue has been resolved.

TITLES - Titles that have a lease company or a driver will now print the lessee or the driver in box 4 on
the tile application.

RINGLINE — When offline the ringline will be printed at the bottom of the Title Application page in the
same format as if you were on line.

SAVE CORPORATE OWNERS - Corporate owner that have been added will now save to the database
for further look ups.

TENDER- CWXML will no longer display tender records with a 0 receipt number

MAAP ASSIGN SUPERVISOR - You will get a message stating you cannot assign a supervisor unless
you are logged into MAAP.

PLATE INVENTORY — When you use the SEARCH BY PLATE criteria it will now locate the closest plate
when typed in.

OWNERS - When there are two owners in a Receipt Screen if you highlight the 2" owner and click on
Legal address you see Legal address, if you immediately click on the Mailing address you will now see
the Mailing address for the 2" owner

1.1.2.64 Release Date June 7, 2006 New Table (VINman)

OWNERS - If there is one owner without an ID number, a message will appear to let you know which
owner is missing the ID number.

FANTOM SECOND OWNER — A second owner from a previous registration no longer appears on future
receipts. A core clearing issue has been resolved.

ESTIMATES- Users can now search MAAP in Estimates by Plate Number or by VIN.



EXIT DOOR- Exit door is activated in CTA Sellers.

CLEAR MV SCREEN- The “Clear MV Screen” option of the right click menu clears all data from the
receipts including current charges. Total Charges remain. F10 also clears the MV Screen.

CORPORATE OWNERS — Corporate Owner names were not always held in the Primary Owner Field.
This has been fixed and the Corporate Owner names are now held at all times.

ACCESS VIOLATIONS- Users sometimes received Access violations when trying to search a corporation
by Corporate ID. These access violations have been eliminated.

EXPIRATION DATES ON RENEWALS- When pulling in a plate from MAAP, the expiration date was not
always accurate. ClerkWorks now takes the last expiration date being returned by MAAP for a renewal
and adds a year.

GENERAL MESSAGE LINE- ClerkWorks XML will now hold only the current CTA number in the message
line.

MAKES PER THE STATE - There is a new VINMan table. This is a table of manufacture (make) list
based on 1st three digits of the VIN. This State provided information has been incorporated into the
program. CWXML no longer uses the Linkworld table for makes.

The program in several places validates the VIN against the table to get the right make.

USER NAME - Users will no longer be allowed to put a space in front of the MAAP user name. This field
has been trimmed.

NON-RESIDENT — The non-resident check box in the owner has been moved so it will now process in
the correct order.

1.1.2.63 Release Date June 1, 2006 Table Changes

ACCESS VIOLATIONS — Users sometimes received Access Violations when pulling in a registration that
specifically had a Corporate Owner as the Primary and an Individual Owner as the secondary owner.
The code was changed to accept this and the access violations will no longer occur in this circumstance.

FAULT MESSAGES - Fault Messages will now be shown all at once in a new format. Users should click
on one and the resolution and notes will populate the boxes below. To see the resolution for the next
fault, simply hit enter. Users are also able to copy and paste CTA numbers, Title Numbers etc. from the
message rather than having to do it from the Communicator.

NON-RESIDENT - ClerkWorks XML now allows the non-resident box in the additional information box of
the owner’s window to be checked off. You need to put the Mailing Address as the non-NH state address
and the Legal Address as the NH address.

NON-RESIDENT — There is now a Non-Resident option in the General Messages drop down box.
PREVIOUS TITLE NUMBER- The previous title number has been extended to accept 17 characters.
VOIDING RECEIPTS — A typo has been fixed in a warning that you cannot void receipts.

CTA SELLERS — The exit door is now enabled in the CTA Sellers window.

COMPANY DRIVERS - There is now a ‘driver’ option in the owner role field of a receipt. This option
comes into play when a company owns a vehicle but needs to have a local connection on the registration.
The user would put the company name in the first owner box with the role as primary. The driver or local
connection would be put in the additional owner field with ‘driver’ chosen in the role field from the drop

down arrow. This translates to the title as well.

1.1.2.62 Release Date May 17,2006



FLEXILOAD - Flexiload has been enhanced to run from ClerkWorks XML. Users will no longer use
CWUpdater to run their Flexiload. Simply run it from the Administration menu. ClerkWorks will download
the data via the web.

VOID & EDIT — Users will not be able to void a receipt that has already Fee Settled successfully. A
message will appear that states “You cannot void a receipt that has already been fee settled.”

MAAP COMMUNICATOR - There is now a Magnifying Glass button in the toolbar. You can search a
particular receipt number in the communicator. It will prompt you to type in the receipt no you are looking
for.

SELLER NAMES - You will not be able to type the sellers name directly on the CTA. You will have to go
to the ellipse, search it and select, just as if you were using the owners table.

TITLE NO — The viewable length for Previous Title No has been increased. You should now be able to
see the entire number when putting in a lengthy title no.

EXIT DOOR — Now works in File>Check Validate

VALIDATION STICKERS — The correct type of sticker, whether it is Double or Single, will now be brought
in when you hit F6 to get to the inventory.

REG HISTORY - If realize you have the wrong audit number on receipt, you can now change it directly
on the receipt, it will write to REG HISTORY.

LEASE COMPANIES — There is now a lease indicator in the owner look up. If the indicator is not
checked off, and this is a lease company, you will have to edit the owner, and click off lease company.

DOG LICENSING - If you try to use a license no already issues a warning will appear “This license no
has already been issued for this license year. Would you like to re-enter a new license no?”

DOG LICENSING - If you try to issue a license no to someone who has already been done, a warning

will appear that states “It appears this license may have already been renewed for this year. Return
and select another?”

State Release Release Date May 19, 2006

SALVAGE TITLED VEHICLES - If the last title issued was a salvage title and there is a salvage decal on
the vehicle, MAAP should let you process the vehicle.

SALVAGED VEHICLES — Can now transfer a salvage vehicle back to the original owner.

LEASE COMPANY- A Leasing Company re-leases a car to a different driver. Previously, the prior
driver’s plates would have to be released in order to process the new registration for the new driver. This
problem has been resolved and users should treat this situation as a new registration with no plate
release.

PLATE MAINTENANCE — When do a plate release from one plate type to another it will not charge extra
state fees based on reg weight.

TITLE APPLICATION - Users can now disable the MCO indicator if they put in the previous title number.
TITLE — MAAP now returns a previous title number when one exists.

CORPORATE ADDRESS CHANGE - Users will no longer receive an error message when trying to
change a corporate address. A Supervisor Override is still required.

LIENHOLDER ID — The ID number for the lienholder can now be less then 4 digits.

1.1.2.60 Release Date May 7, 2006



TRANSFER MO CALCULATIONS — Now if a customer Transfers in his/her Renewal (that was done for
the following year ie renewed for 2007 transfers in the same month) the system will charge for 13 months.
This will only be evident when there is in increase in weight.

RELEASE PLATE BUTTON — The Release Plate Button has been moved from the second Plate Number
field to the second Plate Type field. Now when a user enters the plate number manually, as opposed to
choosing from F6 where the program will automatically enter the plate type, the user will move to the
Plate Type field and enter it THEN click on the Picture icon to evolve the Release Reason Screen.
PLATE INVENTORY — The sort order on the plate inventory has been reversed so the lowest numbers

are on top. Also, HPASS has been sorted within the Plate Inventory list as opposed to being at the
bottom.

E-REG - Typo fixed “syncronize’ to “synchronize”

1.1.2.59 Release Date May 5, 2006

REG HISTORY — When changing or adding an Owner’s Name in Reg History, it will change it on the CTA
Associated with that VIN in the local data. Simply click on the ellipse in the Owner’s Tab, select correct
owner’'s name. When you pull up the CTA, the owner’s name will be changed here as well.

FEE SETTLEMENT — A message will pop up when you have fee settled successfully.

ACTION MENU - It now goes in this order PROCESS, TENDER, FEE SETTLE, PRINT REGISTRATION,
PRINT TITLE (IF APPLICABLE), PRINT CHECK VALIDATION, NEW RECEIPT.

1.1.2.55 Release Date April 24, 2006 TABLE CHANGES

VOID AND EDIT — When processing offline or on-line, you can now enter the MAAP Username in the
space provide and then hit the UPDATE MAAP CLOSEOUT INFO TO TENDERS button. This will update
the Tender table so that your reports and for closeout will be accurate.

F7 — Now the system will retain the audit number when using F7 to bring in information from MAAP.

MAAP SEARCH ACTIVE — The MAAP search is now active in the Corporate Owner Screen so users can
pull in a Corporate Owners ID number.

OFF LINE RECEIPT — Now when a Motor Vehicle operation is performed while off line with MAAP the
system will write the following data into Void and Edit and Reg History upon a reconnect and AFTER
processing online.

e Transaction ID number
e Town Code
e User number

E-REG LOADER — The E-Reg Loader used only by the City of Manchester has been updated to stamp
the create date once the record is loaded.

E-REG - The program has been adjusted so that no checks will be printed if the account number or the
ABA number is blank.

E-REG - There are new Admin -> System (Vehicle Tab) options to the program.
e E-Reg Checking Account Supervisor Override User (blank for not required)

E-Reg users can now have a second person monitor any changes to an account number
located in Edit and Approve Logs. This second person (Supervisor) must be set up in the



Clerk Master with a user name. This second persons (Supervisor) user name must be in
the blank field at the end of this Supervisor Override option. If the field at the end of this
Supervisor Override option is left blank then a supervisor override will not be necessary
to change an account number that is in the system.

e Preserve EB2GovLog Checking Account number (cleared by default after print)

Users now can choose to Clear account numbers or to Preserve account numbers in
their system after the checks have been printed. If this box is checked off all account
numbers in Edit and Approve Logs will remain intact. If this box is not checked (and by
default it is not checked off) then the checking account numbers will be cleared after the
checks have been printed and the user chooses YES to the message:

“Please wait until all checks have been printed and press YES if all checks
printed or NO if you need to reprint.”

E-REG - The synchronization engine has been modified and tightened up. Now if the Abort is
accidentally clicked while synchronizing the program will better know exactly where it left off and allow the
user to pick up exactly where it left off instead of potentially missing a full block of 100. The message has
been altered as well. (Manchester)

E-REG CLIENT VERSION ONLY — The Touch date on the EB2GOVLOG.adt record will now be updated.
The Touch date will allow be updated when the synchronizer writes back to the EB2GOVLOG.adt.
(Manchester)

1.1.2.54 Release Date April 21, 2006

TRANSACTION INFO IN VOID AND EDIT - If the transaction information is not in the Void and Edit
screen users may now edit it or add it. The information edited or added will write to Reg. History and
write the Transaction Date to the Tender file. Only on RARE occasions does this information have to be
added. In most cases a fee settlement may have been done on a previous day or via cash mail.

1.1.2.53 Release Date April 11, 2006 TABLE CHANGES

REPRINT REGISTRATION — There is a drop down for the REASON for reprint. Just highlight the one
you want and hit enter or you can just type it in.

REPRINT REGISTRATION — Will put the Receipt Number as well as all the miscellaneous fees (ie: AFEE
2.50, TFEE 2.00) as if it were the original.

OPEN RECEIPT — When processing from an open receipt, the Transfer credits will calculate as well as
the correct month and mills.

F6 AT PLATE TYPE - You can now select a PLATE TYPE at the first plate number field, by hitting F6 and
then select.

SHORT SLIPS - If you are doing a short slip and need to enter the code RHDONTUEOQ1, put this in the
name key area. After printing out the Registration, then Print the Slip from the Action Menu.

RED DOOR - The red door now works in Search Local Owners.

1.1.2.52 Release Date April 10, 2006 TABLE CHANGES

PLATE MASTER FOR FREE TRAILER - For “free” state trailers, the weight must be set at zero and the
Agent Fee ($2.50) shouldn’t be charged. There is a new When clause in the plate master (W). When
checked, will suppress the AFEE on transactions with a weight of zero. This should be applied to the
TRAI plate. The Radio Button at the bottom of the When clause should have When Both Apply,
meaning both S (State Work) and W (State Weight > 0).



CHECK VALIDATION — There is now a third option to print the Check Validation for the State or the Local
checks. Motor Vehicle -> Reg History there is now a bar at the bottom “Check Validation”. This will
prompt the user for the State or Local Validation. This option was added in cases where the Check was
not validated from the Action Menu or from File->Validate Checks is not an option because the Receipts
were posted.

DOGS CIVIL FORFEITURES - A new feature allowing the two logical prompts to be dynamically changed
after processing a license have been added. This should help when people have Civil Forfeitures that
they want turned to false after processing. These are set up in the group master. It should be self
explanatory. (Londonderry)

1.1.251 Release Date April 6, 2006

CANCEL RECEIPTS — When Cancel Receipt>Cancel Entire Receipt> it will no longer advance the audit
numbers.

E-REG - A new Security feature has been added relating to modifying checking account numbers in the
E-Reg Edit and Approve Log. To invoke this new feature the System Master you can now enter a
supervisor override name. If the System Master has a user name entered the ClerkWorks user will be
prompted for the “supervisor” to enter his/her username and password if the account number is changed.
This can be any user or a new user set up just for this purpose. The prompt only occurs if there is a
name entered into the Override supervisor prompt in the system master (Admin->System; Vehicle Tab).
(Londonderry) (This is also explained differently under Version release 1.1.2.55)

1.1.2.50 Release Date April 2, 2006

E-REG - If the State Weight Limits in the Plate Master is more than 5 9’s that Plate will not synchronize to
the EB2Gov Server. Go into all Plates to check the number of 9's that are in the State Weight Limit Field.

STICKER YEAR — The Sticker Year will now appear on the State Audit Report as well as the Reg History
file. It was previously not writing to the Sticker Year field in Reg. History. Sticker Inventory is working fine
with no changes.

REPRINT REG — Reprinting from Reg History has been enhanced to work better.

o If the Audit Number is corrected in Reg History and a Reg is Reprinted the correct Audit number
will appear in the dialog box
e Print Ringline will prompt the user to print the Title Ringline or the Registration Ringline

REPRINT REG — When done off the Action Menu, and there are more than one to be reprinted at a time,
you can now select them individually. It will fill in the boxes with the appropriate information pertaining to
that particular plate.

TRANSACTION ID — The Transaction ID is returned from MAAP when Process on the Action Menu is
invoked. Reg History will retain the Transaction ID on each Reg History file and if a title was done there
will be two Transaction id’'s recorded.

e The Title ID is in the “MAAP Title Trans” field (if there is no Title this field is blank)

e The Registration ID is in the MAAP Tab in the lower screen “Financial Trans. No.”
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FINANCIAL MEMOS - When doing financial memos through the Tender Screen of a transaction,
whatever appears in the “NAME KEY” field will be that name or number printed on the financial slip. If it
is a Research Do Not Use type of financial memo, that Code should appear in the Name Key field on the
tender screen in order that the specific person is not charged for that financial memo.

Print Registrations | Frirt Ringline |

STATE WORK ONLY - When bringing in a registration from MAAP and F5 (State Work Only) is used, the
expiration date will have the correct year for renewal.

TITLE — when getting a CTA number from MAAP and it is not a dummy, after you uncheck “dummy” the
cursor will be at the search title field. You can then tab to Type.

When a vehicle does not exist it MAAP, the year of the vehicle is left blank.

STICKER INVENTORY - If your town is not a multi-user, meaning more than one user at a time, you can
now enter the inventory under ADMIN or a user name. If you do not want to split the stickers up, by
assigning a certain amount to one or the other, have all the Status on “Available”, Sticker Type on what
you send and Assigned Clerk on “ALL". This will allow you to pick each number sequentially.

1.1.2.49 Release Date March 29, 2006

MAX NUMBER OF WORKAREAS — The program has been adjusted to mitigate the Max Number of Work

Areas error message. Make sure you only have one ADSLOCAL.CFG file. Increase the WORKAREAS=
as well as the TABLES= in this file as needed.

1.1.2.48 Release Date March 24, 2006
PLATE MASTER - The Plate Master edit screen is now sizable so you can see all the Other fees on one
screen.

1.1.2.47 Release Date March 9, 2006

EB2GOV / E-REG — After your checks are printed correctly, the account numbers will not be accessible
except to Administrators. So be sure the checks printed correctly before saying yes. This new release
contains code that restricts access to banking account number. Only administrators can change the local
and state check amounts. After checks are printed the account nhumbers will be cleared. Also, only




administrators can do a check reprint and only after a resynchronization of the log to regain the account
number.

3" RATE — Now on a New Third Rate vehicles are automatically calculated. The system will read the
Body Style and automatically calculate the 3" rate.

NEW DICTIONARY FILES — Titles printing issue resolved when the New dictionary files are run. There
was a missing field in the titles table, which gave an access violation.

1.1.2.46 Release date March 6, 2006

SYSTEM PROMPTS FOR 1°" AUDIT NUMBER OF THE DAY - When logging in for the first time during
the day, you will be prompted to enter the Audit No. This will decrease the odds of a wrong audit number
being sent to the state on your first transaction of the day. This is particularly helpful when more than one
person uses the same workstation.

3" RATE — On a renewal or a transfer the 1/3 Rate pop up should appear automatically and calculate
properly. On a new vehicle you will have to go to Motor Vehicles >Special Opts>Third Rate in order for
the rate to be applied properly.

NO TRANSACTION ID REQUIRED - When working offline, in Licensing or POS no Transaction ID# is
necessary in order to post.

PROMPT FOR OUT OF SEQUENCE - A prompt has been added when a decal or a plate being issued is
out of sequence. After checking to make sure they are right, Click OK and continue.

** VVIN MISMATCHES - If the MFG Year comes back as not correct, (i.e. On trailer VINs which are usually
non-conforming even though they have 17 digits), click on the NC box and resend. MAAP will bypass the
VIN Checking against the Manufacture Year, Model, Year, etc.

1.1.2.44 Release date March 1, 2006

CONEQ - The plate maintenance action is fixed relative to charging the conservation fee. In order to do
this, you must add another SCON in the plate master with a when of ‘IR’. Recognize that SCON will be in
your plate twice.

SCONEQ - the transaction code for SCONEQ should have a Basis of MODEL on a MO to calculate the
Coneq fees correctly including the prorated for the smaller ones. This will now calculate the prorated fees
for the State properly.

** PRINTING MULITPLE REGISTRATIONS WITH TITLES - When processing more than one title and
registration, and then doing a Title only on the same receipt, all the registrations will print first and the
Titles will print second. When printing the titles, it will prompt you for each individual CTA number that was
entered.

1.1.2.43 Release date February 13, 2006

EB2GOV / E-REG — A change has been made on the EB2GOV server relative to E-Reg. Now when a
CONEQ Plate is calculated on EB2GOV it will round as ClerkWorks does ie: $ 25.00 instead of $ 24.99.

E-REG EDIT AND APPROVE LOGS - The following changes have been made to Edit & Approve Logs:
e Change the Status of a Log — Highlight the record and Right Click to expose the menu, choose
Change Status, a window will appear with the current status and a field to enter the status you
would like to change the record to.
¢ An additional Status has been added: V for Void
e Logs are now listed in Descending order with the most recent at the top
e When Approving Logs you no longer have to move off the Check Box for the record to save



E-REG PRINT CHECK - If user lets system assign checks then the Auto Assign radio button should be
on. If user wants to enter in with the Select radio button on and wants to enter the check number it will
remember the last check number.

E-REG CLIENT XML — On an E-Reg Client ONLY (where the customer does not process Registrations
on ClerkWorks) Now when a check has been printed the status in the Edit and Approve Logs will change
from a C (Confirmed) to a P (Processed).

1.1.2.40 Release date February 8, 2006

PROMPTS FOR PARENTAL CONSENT FORM - When a person is under 18 years of age you will now
be prompted to remember to submit the Pink Form in your documents prior to processing. The P will
automatically be added to the record as the program calculates the DOB against the system date.

MERGE RECEIPTS - Merge receipts has been modified to merge POS or Licenses into a MV receipt. It
is not suggested that after a successful transaction to MAAP has been stamped onto your Void and Edit
that these receipts do get merged into another MV receipt. The tenders may have to be manually
adjusted.

DT and TS DEFAULT - The Application Origin for a title will now default to either “DT” (Dealer Town) or
“TS” (Town State) depending on the Title Activity entered on the receipt.

CHANGE ADDRESS - You only have to change a customer’s address on one transaction on the receipt.
It does not matter if it is the first, the middle or the last one. The customer’s address will carry forward to
all the registrations. Be aware though, if there is more than one listing for that customer in the Owners
table, you will have to consolidate their vehicles before this feature will work on all their vehicles.

1.1.2.39 Release date February 6, 2006
WRITES DATA - If MAAP transaction information is missing, you can now type it in Reg History or Void &

Edit and it will write to other. Keep in mind there is more information required in Reg History then in Void
& Edit.

SEARCH SELLER - You can search a Seller, whether an individual or a Corporation, in MAAP on the title
screen.

TITLE WEIGHT - If a title weight is found with a vehicle it will be automatically resent to MAAP.
F7/EXPIRATION DATE - F7 now brings in the expiration date on a receipt.
F5 (STATE WORK ONLY) TOGGLES - When you inadvertently pressed F5 “State Work Only” and then

realized you made a mistake, if you press F5 again, it will release the receipt to calculate to do town and
state.

1.1.2.38 Release date January 24, 2006

GENERAL MESSAGE DROP DOWN - There is now a drop down in the general message field where you
can pick whether this is a name change or an address change.

LEASED VEHICLE ADDRESSES - When doing a lease vehicle, it will now automatically put the lessee’s
address for the mailing address and the lessor’s address for the legal address.

CHECK VALIDATION FROM FILE - When doing check validations from FILE, the current date is the
default.

Duplicate registrations: After typing in plate number in Previous Plate Field, it will prompt you that there
is not enough information - do you want to load from MAAP. You would say yes in order to get the last
months/mills. It will then bring up the reason field, click on the radial button that pertains and process. It
will print “Duplicate Reg” and the reason in the General Messages Field.



1.1.2.37 Release date January 19, 2006

This new release contains code that restricts access to banking account number. Only administrators
can change the local and state amounts. Also, only administrators can do a check reprint.

1.1.2.36 Release date January 13, 2006

E-REG - This release solves a problem with synchronizing E-Reg where it was getting hung up at
TCMessages when resynching. It also seeks to mitigate the title weight issue. If the title weight is
missing, it will now try to get it from MAAP.

1.1.2.35 Release date January 10, 2005

This release resolves the issue with names strangely changing however note that this fix favors the owner
links and not the name that may reside on the regmaster record. In this case (and | would be most
interested if this is widespread), the user should load the record, go to the owners tab and find the proper
owner(s).

1.1.2.34 Release date December 28, 2005

VOIDING RECEIPT - Voiding a Receipt in Void and Edit will now void the receipt and set the tender
screen to 0.

CANCEL TRANASCTIONS - File -> Cancel Transaction and Choose either “Cancel Entire Receipt” or
“Cancel Transaction”. This allows you to either cancel the entire receipt or just one transaction if there
are more than one vehicle transaction on that receipt. When you choose Cancel Entire Receipt, it will
cancel the MAAP transaction as well as clear your records and put the Vehicle Maintenance back to its
previous state as if the customer never showed up.

MAAP -> CANCEL ALL TRANSACTIONS - MAAP -> Cancel all Transactions will cancel the MAAP
transaction but will not clear the screen. This gives you the option to make changes and then to re-
process any changes made to that transaction as if for the first time. It will not put the Vehicle
Maintenance back to its previous state.

CHECK VALIDATION - Check Validation can now be performed on the Action Menu as a separate
action, or found in File -> Check Validation. The Action Menu selection will prompt you to validate your
checks at that time (while the customer is there). If you choose File>Check Validation, you can validate
all your checks at the end of the day. You simply select the appropriate check and click on the printer
icon.

SWAP LEASE COMPANY IN SPECIAL OPS - Lease to Owner — Motor Vehicles -> Special Options ->
Lease to Owner will swap the lease company for the owner and will calculate accordingly.
1.1.2.29 Release date November 30, 2005

State Fees different from ClerkWorks fees warning. - When do a new registration with a CTA this warning
will not come up.

ShortSlips — you can now create a short slip when paying off a shortslip.

E-REG — Enhancements Release Date December 15, 2005

This new release contains code that restricts access to banking account number. Only administrators
can change the local and state check amounts. After checks are printed the account numbers will be
cleared. Also, only administrators can do a check reprint and only after a resynchronization of the log to
regain the account number.

These changes were made at the EB2Gov Server. No ClerkWorks update is necessary to realize these
enhancements.



1. Special Messages NHNG Plates - When a citizen selects to renew a vehicle with NHNG plates,
they will be provided a message that indicates the special form that needs to be filled out and
invites them to download it.

2. Special Messages Under Age 18 owner - When a citizen selects to renew a vehicle where the
owner is under the age of 18 they will be provided a message that indicates the special form that
needs to be filled out and invites them to download it.

3. E-Reg Messages - The most recent versions of ClerkWorks and ClerkWorks XML now allow
users to post messages that will be displayed to customers. These are identified in the message
center as E-Reg Messages. What is entered here will be synchronized to E-Reg and displayed to
the user. Messages tagged as an Urgent Message prevent the vehicle from being renewed via
E-Reg but will still display the E-Reg Message. To allow the customer to continue with the
process, tag the message as Normal or Info.

4. PIN Messages - When registering vehicles via a PIN, messages will be offered the customer on
the checkout page next to each individual record that has a message attached to it whether it is a
"Special Message (NHNG/Under Age) or an E-Reg Message. Users can click the link and get the
message including any special downloads.

5. Clearing Messages — Now, when a message is cleared in ClerkWorks and Synchronized the
message will be cleared on the record at the EB2Gov Server.

6. User Provided FAQ's — E-Reg now provides the user the option of providing their own FAQ.
Users can create a web page containing FAQ's (Frequently Asked Questions). To link the user
defined FAQ page, the user will log into EB2Gov and provide the full link in the profile.

7. Dynamic Registration Count - On the first page of E-Reg, the page now displays an up-to-the-
minute count of synchronized E-Reg transactions.

8. Pre-Calc Registrations - There is a new option called Pre-Calc. This is primarily for cities and
towns that do not use ClerkWorks. It allows the client to pre-calculate local and state fees and
synchronize them. This prevents E-Reg from making the calculation. Note: There is currently no
support for this in ClerkWorks and if users choose to use Pre-Calc, the "Show me the Detail"
option is not available.

9. Changed Language - In the Totals Section of the Checkout page, the verbiage has been made a
little easier to understand if both options (E-Check, By Mail) are not included.

10. The EB2Gov Check report “EB2GovCheck.rpt” has been modified to accommodate an excessive
amount of Plate Numbers in the memo field. See details in the report section of this document.

EB2GOV - Enhancement

e ABA Bank Master - On rare occasions a customer has called and indicated that the bank routing
number being used is not found. In those circumstances, we have had to manually enter the
bank information. EB2Gov now provides a method for users to enter the bank manually by
selecting the ABABank Master option from the EB2Gov menu.

COMMUNICATIONS FROM THE STATE:

7-7-06 Email from Kelly Brudniack

E-cash/cash mail is only intended to be used when the State system is down
and items have to be processed off-line. The money is deposited the day
taken, and then the transactions are processed the next day live, using e-
cash/cash mail. Clerks should not be processing offline unless the system is
down.

7-11-06 IDC/BMSI/State meeting in Concord-These are some issues that the State would like us to
stress to our users:
1) One of the issues we discussed was the PA#s not matching when the DMV clerks are going
over the document piles. | assume that's because occasionally we have to print from reg history.
We should stress to always use Reprint Registration, except for cases such as this. Interware is



working on a Reprint from Reg History to soon have audit number adjustment pop up screens so the
new Audit number will be transmitted to MAAP.

2) The new quick reference notes have detailed explanations about shortslips/bypass/credits. The
latest can be found on www.ClerkWorks.com -> MAAP

3) Regarding releasing plates, we should also stress that they need to call the MA desk first before
they release the plate to confirm that it is still available.

4) We should remind towns of the Application Origin list in their manual. This is a very important
field that effects the way the State handles the Title and Charges. Clerks must pay close attention to
the TS, DS.

5) We can suggest that Clerks can fax their sticker and plate inventory lists to the warehouse
instead of mailing them; a more efficient and timely manner.

7-13-06 Jeremy called and said that some clerks (primarily Derry) are putting C/O in the prior title field.
They should not do this, instead they should use the MCO indicator check box.

7-17-06 Kelly Brudinaik and Pricilla Vaughn have determined that there is enough new information that
needs to be covered by the State to have a State training fro Vendor Towns coming on board or currently
on board with MAAP. Sandy submitted a list of training issues several months ago for the State to
review. This list is available upon request to IDC or BMSI. It may assist you in detraining if it would be
beneficial for you to take. It may be a 2 day course.



